
Mirage
free 3D modeling and rendering

This  is  the  second  release  of
Mirage, but the first version that
I  would  consider  complete.
Mirage  is  a  free  3D modeling
and rendering program, so I’m
asking nothing in return for  it,
but I would appreciate everyone
who likes it to help distribute it
(keeping  all  the  files  grouped
and intact) and to send me any
comments  you  may  have  or
cool  pictures  you  make.  My



address is:

Mike Clifton
1013 Thistle Ct.
Sunnyvale, CA 94086
email: 
clifton@cse.ucsc.edu

I’ve been working to speed up
Mirage and improve it  overall.
Some  of  these  changes  have
restricted  which  computers  are
capable of running Mirage. This
program  requires  a  color
Macintosh running System 7 or
later.  32-Bit  QuickDraw  is



required  for  off  screen
processing of images.
There  have  been  several

improvements  since  the  last
version  of  Mirage  that  I  feel
make  the  program  more
complete and usable. The most
important of these are:

• wireframe  drawing  speed
has  been  increased  for
curved surfaces

• rendering  speed  has  been
increased

• texture previews and final
renderings  are  now



processed  off  screen,
allowing for 32 bit color on
all machines and preventing
images  from  disappearing
after screen savers take over
the monitor

• dithering  is  now  used  to
create  good images  even in
8-bit  (256  Color)  mode  (In
the  previous  version,  16 bit
color  was  almost  a
requirement  for  decent
results)

• the  smoothing  effect  on
objects  uses  a  dialog  that
gives  more  predictable



results
• previously,  “cracks”
sometimes  appeared  in
surfaces,  especially  around
the  edges  of  a  scene.  This
has been fixed.

• double-clicking  on  an
object’s  name  now  allows
you to change the name

• 3D  objects  and  Mirage
files  now  occupy  less
memory, so more objects can
be used in a scene

• copy  /  paste  commands
are available in the material
editor,  making  it  easier  to



use  the  same  texture  on
multiple objects

• the  print  command  now
prints  the  current  modeling
window  views  to  whatever
printer you may be using

• Mirage  will  save  to  a
PICT  file  either  the
wireframe  views  or  a
rendered image - your choice

• saving  a  rendered  image
to a PICT file is no longer an
awkward procedure. It works
quickly and cleanly.

• pressing the mouse button
during  a  rendering  cancels



the operation
• when  rendering  a  scene,
the  user  doesn’t  have  to
specify the z-buffer depth

• temporary  files  generated
by Mirage are much smaller
and Mirage cleans them out
when it’s through with them

Known bugs:



• PICT  files  created  by
Mirage  are  not  compatible
with Photoshop. They can be
read  by  every  other  PICT-
reading  program  I’ve  tried,
but  Photoshop  seems  picky
about it.

•  IMPORTANT!   This
version  of  Mirage  is  not
capable  of  reading  files
created  by  the  previous
Mirage  and  vice  versa.  If
you try it, it may crash. From
now  on,  I  will  ensure
compatibility  between
releases, but the first version



of  Mirage  was  actually  a
kind  of  pre-release.  If  you
want to use an old file with
this  version  of  Mirage,
export the file as text in the
old program and import  the
text  file  into  this  one.  The
text  format  files  are
compatible.

The  menu  commands  and
controls  for  Mirage  are
basically the same as before, so
if  you’ve  used  them,  you  can
skip this section. (Then again, I
never typed up a manual before,



so  you  might  not  know  this
anyhow.)

Main Window

There  are  three  areas  of
interest  in  the  main  window.
The  top  left  corner  shows  a
scrolling list. This is where you
see  your  objects’  names  and
select them. The first six objects
- Eye, Lookat, Light 1, Light 2,
Light 3, and Light 4 are always
in  every  Mirage  document.
Below  these  you  will  see  the
names of objects you create. To



select  the  object  you  want  to
work with, click on its name in
the  list.  To  change  an  object’s
name, double-click on it.
Below the object list are nine

buttons.  The  top  three  let  you
select  the  current  modeling
operation:  translation  ( ),
scaling ( ), or rotation ( ). The
next  five  buttons  select  the
current  view:  four-way  ( ),
front ( ), top ( ), right ( ), or
perspective  ( ).  The  final
button lets  you toggle the grid
feature on and off ( ), making
it easier to align objects.



The rest  of  the main window
consists of the modeling views.
In  the  four-way  view,  the  top
left box is the top view, bottom
left  is  front,  top  right  is
perspective, and bottom right is
the right view. The perspective
view is normally not updated so
that  it  won’t  slow thing down.
Periodically  you  will  want  to
update  the  perspective  view to
see  the  scene  through  the
camera. To update it, just click
the  mouse  in  the  perspective
view.  The  perspective  view  is
where  all  final  rendering takes



place, so it will either be the top
right  corner  in  the  four-way
view or the entire window in the
perspective view.
Transforming  objects:  select

the  object  you  want  to
transform  and  the  button
corresponding  to  the  selected
transformation. Press and move
the  mouse  in  one  of  the
modeling views. The view you
choose  will  affect  the
transformation.  Translation
moves  the  object  in  the  view
you click in. Scaling scales the
object  relative  to  its  original



orientation  in  that  view.
Rotation also works based on an
object’s  original  orientation.
The  shift  key  can  be  used
during  a  transformation.  For
translation,  it  limits  motion  to
either horizontal or vertical. For
scaling,  the  object  is  scaled
proportionately  in  all
dimensions.  For  rotation,  the
angle  is  limited  to  15-degree
increments.

Menus

The File menu works basically



as  expected.  Three  commands
to note are: Import, Export, and
Save  as  PICT.  Normally,
Mirage files should be saved in
the  native  Mirage  format  with
the standard Save As and Open
commands.  However,  they  can
also be saved in a text format.
Export  will  save  a  file  in  text
format and Import will read in a
text  file.  The  exact  format  for
these text files is described later
in  this  document.  The  reason
Mirage  has  this  capability  is
because I  do a  lot  of  work on
Silicon Graphics computers and



I  wanted  to  create  a  simple,
portable  3D  file  format  that
could be used on both SGI’s and
Macs. You 



can  use  this  file  format  if
you’re doing your own graphics
programming and  you  want  to
generate models in Mirage and
easily  read  them  into  your
program  or  if  you  create  a
program that builds models that
you  want  to  load  into  Mirage.
Finally,  the  Save  as  PICT
command allows you to save a
wireframe  drawing  or  a
rendered  image  as  a  picture.
Whichever  you choose to save
to  a  PICT  file,  only  what  is
currently  in  view  in  the  main
window will be saved.



The  Edit  menu  currently
doesn’t  have  any  working
commands.  Sorry.  If  you  want
to copy and paste,  here’s what
to do: select the object you wish
to  copy.  Choose  the  Export
Object  command in the Object
menu. This will save the object
in a file by itself. Now create a
new  object  of  the  type
“Imported  Text”  (see  the  New
Object  command  below).
Mirage will ask you which file
you want to import.  Select  the
file that you just exported. You
will  now  have  two  identical



objects  right  on  top  of  each
other, so just move one of them
off to the side.
The  Object  menu  has

commands for manipulating 3D
objects.  New object  will  bring
up a dialog letting you name a
new  object  and  choose  what
type  of  object  it  will  be.  The
current  options  are  Lathe,
Extrusion,  and  Imported  Text.
Choose the type you want and
hit OK. Lathe and extrude will
open a window letting you draw
the outline curves, while import
text will ask you to choose the



file  you want  to  import.  Lathe
objects are made by revolving a
profile around an axis like this:

Extrusion objects are made by
stretching out a 2D outline into
three dimensions. Note that for
extruded  objects,  you  should
only  use  polygons  that  are
convex, not concave.



The Edit Object command lets
you modify an object by editing
or adding to its outline curves.
For imported text objects it asks
you to choose another text file.
(If  the  whole  document  is  an
imported text file, all objects in
it are considered to be imported
and  cannot  have  their  curves
edited.)  Remove  removes  an
object  from  the  scene.  The
object  is  deleted  and  gone
forever.  Redraw  redraws  the
selected  object.  You  should
never  need  this  command,  but
it’s  there  in  case  an  object



becomes  somehow  corrupted-
looking.  The  last  command  is
Export.  This  lets  you  save  an
object  in  a  text  format  that  is
described  later  in  this
document. This can be used to
simulate  a  copy  /  paste
operation or to use an object in 



another  program  that  you
wrote  yourself.  (I  use  it  to
create  objects  that  can  be
transferred  to  Silicon  Graphics
computers)
Next is the Effects menu. This

menu is  used  to  apply  various
effects  to  objects.  The  Noise
command will add “noise” to an
object’s  surface,  in  effect
making  an  object  lumpy,
jagged, or just slightly warped,
depending  on  the  settings  you
provide. The Smooth command
lets  you  set  how  smooth  an
object  will  be  rendered.  Just



choose the picture you like. The
default smoothness of 1 is good
for  most  purposes.  A  high
smoothness  doesn’t  add  to  the
amount  of  memory  an  object
occupies,  but  will  increase  the
rendering  time,  so  don’t  just
make  everything  as  smooth  as
possible.  The  Regenerate  will
undo  any  noise  or  smoothing
effects  you’ve  applied  to  an
object, returning it to its original
state. The Material command is
one of the most fun commands
in Mirage and will be described
later.



Finally, the Render menu. The
Wireframe,  Flat,  Smooth,  and
Textured commands render  the
scene in the perspective view or
the top right corner in four-way
view.  Wireframe  renders  the
scene  just  as  outlines.  Flat
draws  objects  with  a  faceted
appearance and tries to go fast
by  guessing  which  surfaces
aren’t visible, but sometimes it
misjudges. Its benefit is that it is
the fastest way of generating a
shaded  image  with  hidden
surfaces removed. Smooth will
do a good, smooth rendering but



without all the texture detail on
surfaces.  In  some  cases  where
you  are  using  many  complex
textures,  this  can  speed  things
up  a  bit.  Textured  goes  a  step
beyond  Smooth  by  adding  in
textured  surfaces.  The  Camera
command  lets  you  adjust  the
camera’s  view  angle.  Usually,
you can just leave it alone. The
Lights  command  lets  you  turn
light  sources  on  and  off  and
adjust their properties. Choose a
color for a light by clicking in
the color box. By default, light
sources  are  at  an  infinite



distance  (like  the  sun).  By
unchecking this option, you can
make  local  light  sources  like
candles.  To make a  light  more
like  a  candle,  increase  one  or
both  of  the  falloff  sliders
slightly.  Press  the  preview
button to see the effect.
IMPORTANT!   When  a

scene  is  rendered  using  Flat,
Smooth,  or  Textured,  Mirage
tries to do the drawing in an off
screen  buffer.  This  allows  for
dithering  and  for  saving  the
image  later.  Also,  if  a  screen
saver comes on, the image will



stay  in  memory  and  can  be
quickly  recalled.  After  the
rendering  is  complete,  the
image will  stay in the window
until  the  current  view  is
changed or another rendering is
started. As long as the image is
still there, it  can be saved to a
PICT file, but when you see the
picture  disappear,  it’s  gone for
good. Sometimes, if there’s not
enough  memory,  the  scene
cannot  be  rendered  off  screen.
In these cases, you will see the
scene  being  drawn  dot  by  dot
instead of in triangular chunks.



If this happens, the picture will
only be  in  memory as  long as
the screen goes unchanged. This
is not a very desirable situation,
so you can cancel the rendering
by pressing the mouse button. If
you  choose  to  let  it  continue,
the  image will  not  be  dithered
and  will  not  look  to  good  on
machines with only 8 bit color.
Also,  saving  it  to  a  PICT file
will  not  succeed,  but  you  can
still  take  a  snapshot  of  the
screen  by  pressing  Shift-
Command-3  Also  if  Mirage  is
drawing  straight  to  the  screen,



watch  out  for  those  screen
savers!
You  may  notice  file(s)  called

“zbuf.00.temp”.  This  file  is
generated  by  Mirage  when  a
rendering is taking place. It may
require disk space in the range
of 400 - 1600K while rendering,
but  after  the  rendering  is
finished, Mirage will empty this
file,  making  its  size  0  bytes.
You can delete  it  if  you want,
but Mirage will just have to re-
create  it  the  next  time  a
rendering is performed.
TIP: To  speed  up  the



rendering  process,  you  can
shrink the  main  window down
to a much smaller size if you’re
just  doing  a  test  rendering.
Then,  for  the  final  rendering,
make the window the size that
you want the final result to be.

Setting Lights and Camera

When  you  choose  Eye,
Lookat,  or one of the lights in
the object list, a small X will be
drawn  in  the  scene  indicating
the position of that object.  For
light  sources,  this  X  indicates



their  location.  Click  in  the
window to  move them. The X
for Lookat  indicates the center
of attention, so place this where
you want the camera to point at.
For Eye, the X indicates 



where your camera is. Use Eye
and  Lookat  together  to  set  up
the camera position,  where the
camera is and what it’s pointing
at.

The Material Editor

The material editor is brought
up by selecting an object from
the list and choosing Material in
the Effects menu.



Choose  colors  for  Color  A,
Color B, and Specular Color by
clicking on the color boxes next
to them. The three alpha sliders
correspond to  the  three  colors.
If a slider is all the way to the
right,  the  color  is  completely



opaque.  If  the  slider  is  to  the
left,  that  color  is  transparent.
Color  A  represents  the  main
color  for  a  material.  Specular
Color is the color of the shiny
highlights  on  an  object.  You
should usually leave this white
and  opaque,  but  it  can  be
adjusted is desired. Color B is a
secondary  color  used  when  a
texture is applied. For example,
in a marble texture, Color A will
be the main color and Color B
will be the color of the veins in
the  marble.  The  Diffuse
Coefficient  slider  controls  how



shiny an object is. To the right,
the  object  gives  only  diffuse
reflections (it’s not shiny at all)
and to the left, the object is only
shiny  and  may  appear  very
bright.  The  shininess  slider
controls  the  size  of  the
highlights  on  the  object.
Moving  the  slider  to  the  right
gives  a  smaller,  sharper
highlight.  The  Copy  Material
button  copies  the  current
material  into  memory  and  the
Paste Material button pastes the
previously  copied  material,
allowing you to copy a material



from one object and apply it to
others. The preview button will
generate a preview of how the 



current  texture  settings  will
appear  on  an  object.  Press  the
mouse  button  to  cancel  a
preview in progress.
Now  to  textures.  To  create

interesting  objects,  there  are  a
variety  of  textures  that  can  be
applied.  There  are  three
categories  of  textures:  color,
turbulence,  and  bump.  The
color  textures  are  Wood,
Marble,  Marble  2,
Checkerboard,  Swiss  Cheese,
Swirl,  Camouflage,  Colored
Noise,  Puffballs,  and  Noise
Blend.  Turbulence  textures  are



X, Y, and Z Turbulence. Bump
textures are Bumps, Veins, and
Snow.  To  make  the  effect  of
bump  textures  more  apparent,
make  the  object  shiny  by
lowering the diffuse slider  and
raising the shininess slider. The
material  editor  allows  you  to
assign  any  four  textures  to  an
object, but there are restrictions
on  what  combinations  work.
You  can  only  use  one  color
texture,  but  any  number  of
turbulence  and/or  bump
textures.  Also,  any  turbulence
textures  must  come  before  the



color  texture.  Turbulence
textures  use  fractals  to
“scramble”  whatever  color
texture comes after them, so the
Marble  texture  by  itself  looks
like  a  bar  of  color,  but  when
used in conjunction with the X
Turbulence texture,  the Marble
looks  like  marble.  The  more
textures  you  use,  the  longer  it
will  take  to  render,  so  if  you
want  to  use  turbulence,  one
turbulence  texture  should  be
sufficient.
Note that the Veins texture is a

special  case.  It  is  both a  color



texture  and  a  bump texture.  It
tries to create raised veins on a
surface whose color is Color B.
In between the veins, however,
another  color  texture  can  be
used as long it is set before the
Veins texture.
An  interesting  effect  that  is

provided  by  textures  is
transparency. Most of the color
textures use two colors (A and
B),  except  Swirl  and
Camouflage. By making one of
these  colors  partially  or
completely transparent, you can
make an object appear to have



holes  in  it.  By  combining
various  textures  and
transparency,  very  interesting
effects  can  be  achieved.  Idea:
using X Turbulence and Noise
Blend,  make  one  color
transparent  and you can create
smoke  and  cloud  effects  by
applying the material to a large
background plane.
The three sliders on the upper

right modify the active textures.
The  Texture  slider  makes  the
color texture being used smaller
or larger, the Noise slider makes
any  turbulence  textures  create



smaller  or  larger  amounts  of
turbulence, and the Bump slider
makes bump textures bring their
bumps closer together or farther
apart.
Making  up  texture

combinations is  pretty fun,  but
can  take  some  playing  around
with.  Look  at  the  examples
included with the program, the
settings  of  the  sliders  and  the
textures used and try modifying
them to see what happens.

Grouping Objects



Grouping  objects  is  not  a
feature of Mirage, but there is a
way to do it. First, in a scene by
itself, create the object that you
want  to  group  together.  For
example,  make  a  chair  out  of
four  legs,  a  seat,  and  a  back.
Now use  the  Export  command
in the File  menu to export  the
scene to a  text  file.  In a  word
processor  you  can  modify  this
text file. First, delete everything
up to the first appearance of the
word  “Object”.  Next,  delete
every  occurrence  of  the  words
“Object” and “End” in the file.



Finally,  on the first  line of the
file,  by itself,  type the number
2721.  You  have  now  grouped
the object.  To use the grouped
object, open a Mirage document
that  you want  to  use  it  in,  for
example a room scene. Choose
New Object  under  the  Objects
menu and set the object type to
Imported Text and open the file
you  just  modified  in  the  word
processor. The chair will appear
as a single, grouped object.

3D Text File Formats



This last section describes the
format  of  the  3D  text  files
created  and  used  by  Mirage.
This section can be completely
ignored  unless  you  are
interested  in  using  Mirage-
generated  models  in  your  own
programs or creating objects for
use  by  Mirage  without  using
Mirage’s tools.
There  are  two  types  of  text

files  Mirage  creates,  one  for
single  objects  and  one  for
complete  scenes.  The  object
format  is  basically  a  subset  of
the scene format, which is 



described  first.  In  the
examples  below,  any  numbers
are  examples  unless  stated
otherwise, anything enclosed by
brackets  {like  this}  will  be
described  later,  anything
preceded by a * symbol is a comment and should not appear in a real file, and

everything else appears exactly as in a Mirage text file. It will probably help if you compare these descriptions with
actual Mirage text files you export from the program.

Scene file:

1272 *ID number used to identify a scene file (use this exact #)
c *camera data

80 30 100 *camera eye position
0 0 0 *camera lookat position
45 *camera viewing angle

l *light source 1
100 100 0 *light position
1 1 *on and infinite settings, respectively (1=checked, 0=unchecked)
1 1 1 *rgb value of light source (range 0-1)
0 0 *falloff 1 and 2 values, respectively

l *light source 2
-100 100 0
0 1
1 1 1
0 0

l *light source 3
0 100 100
0 1
1 1 1
0 0

l *light source 4
0 100 -100
0 1
1 1 1
0 0

Object *one Object, End pair appears for each object in the scene
{object data - described below (brackets don’t appear in actual file)}
End
Object *the second object appears here
{object data - described below (brackets don’t appear in actual file)}
End *third object after this, etc.

Object file:



2721 *ID number used to identify a scene file (use this exact #)
{object data - described below (brackets don’t appear in actual file)}

Object data: (used in both scene and object files)

m *material specification
0.5 0.5 0.5 1 *r,g,b, and alpha of Color A (range 0-1)
0 0 0 1 *r,g,b, and alpha of Color B (range 0-1)
1 1 1 1 *r,g,b, and alpha of Specular Color (range 0-1)
1 0 *Diffuse and Shininess slider values
24 37 6 *Noise, Texture, and Bump slider values
2 *number of textures used (up to 4)
TRBX *a 4-character code for each texture used
MRBL

*Geometry data now follows. An object can have any combination
*of polygons, polygonal patches, and bezier patches. This 
*example illustrates one of each
*Note: a polygon should always have at least 3 vertices,
*should always be convex, and should be defined counter-
*clockwise from the outside if Flat rendering is to have a good
*guess of whether it should be visible.



p 4 *polygon with 4 vertices
-60 25 -30 *x,y,z position of each vertex
-10 25 -30
-10 -25 -30
-60 -25 -30

pp 3 *polygonal patch with 3 vertices
*the next three lines each contain the x,y,z position of a
*vertex, followed by the x,y,z values of the normal vector at
*that vertex

-60 25 -30 10 10 10
-10 25 -30 -10 10 10
-10 -25 -30 10 10 -10

bp 1 *bezier patch with smoothness level of 1 (max smoothness of 2)
-10 25 50 *x,y,z position of each of the 16 control points
-10 8.333333 50
-10 -8.333333 50
-10 -25 50
35 25 42.5
35 8.333333 42.5
35 -8.333333 42.5
35 -25 42.5
42.5 25 25
42.5 8.333333 25
42.5 -8.333333 25
42.5 -25 25
20 25 -20
20 8.333333 -20
20 -8.333333 -20
20 -25 -20

Note that comments are not permitted in Mirage text files. The comments above are only used to describe the format of the
files.
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